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அ஭சு பபொதுத் தேர்வு – ஫ொர்ச் 2023 
11 ஆம் லகுப்பு கணினி ப஬ன்பொடுகள் 

பகுேி - I 
சரி஬ொன லிடைட஬த் தேர்ந்பேடுத்து எழுதுக.     15 X 1 = 15 

1. ஒரு கணிப்பபொமி ஫ீண்டும் ப ொடங்கும் பபொது எந்  லகக஬ொன ப ொடங்கு கயப் 
ப஬ன்படுத்துகிமது.  
(அ) ப ொடு ப ொடக்கம் (ஆ) உைன் பேொைக்கம்  (இ) ப஫ய் ப ொடக்கம்  (ஈ)  ண் ப ொடக்கம்  

2. 00100110 க்கொன 1-ன் நி஭ப்பி எது?  
(அ) 11010001  (ஆ) 00100110    (இ) 00101001  (ஈ) 11011001  

3. CD ஬ின் குகமந்  அரலியொன  ஭லின் அரவு ஬ொது ?  
(அ) பிட்ஸ்   (ஆ) ப ொகு ி   (இ)  டங்கள்  (ஈ) பகு ி  

4. பின்லரும் எது, இ஬க்க அக஫ப்பு பெ஬ல்பொடு அல்ய?  
அ) பொதுகொப்பு ப஫யொண்க஫  ஆ) பெ஬ல்முகம ப஫யொண்க஫  
இ) நி஭ல் பப஬ர்ப்பி சூறல்  ஈ) நிகனலக ப஫யொண்க஫  

5. ெொர஭ங்கரில் ஒரு பகொப்பின் ஫றுபப஬ரிட ப஬ன்படுத் ப்படும் குறுக்குலறி லிகெ 
(அ) F5   (ஆ) F2  (இ) F6  (ஈ) F4 

6. ஏற்கனபல பெய்  பெ஬கய  லிர்க்க உ வும் குறுக்கு லறி ெொலி பெர்஫ொனம் ஬ொது? 
அ) Ctrl + Z   ஆ) Ctrl + E   இ) Ctrl + N   ஈ) Ctrl + U 

7. ஒரு லொய்பொடு இலற்றுள் எ ில் ப ொடங்கயொம்? 
(அ) +  (ஆ) -   (இ) =   (ஈ) இடல஬டனத்தும் 

8. Impress-ல் லிரக்கக் கொட்ெி஬ின் நீட்டிப்கப (extension) அகட஬ொரம் கொணவும்? 
அ) .odb  ஆ) .odp.  இ) .ood  ஈ) .ppt  

9. ம௃எஸ்பி, கலஃகப அடொப்டர்ஸ் எவ்லொறு அகறக்கப்படும்? 
a) Dongles b) Data Card c) Memory Card d) Pen Drive  

10. லரி முமிகல ஏற்படுத்துல ற்கு ……………………ஒட்டு ப஬ன்படுகிமது. 
(a) <html> (b) <h1> (c) <p>  (d) <br>  

11. ஒரு பட்டி஬ல் ப ொகு ி஬ொனது ஫ற்பமொரு பட்டி஬ல் ப ொகு ிக்குள் லக஭஬றுக்கப்பட்டொல் 
அது : 
(அ) Outer List  (ஆ) Inner List  (இ) Listing List  (ஈ) Nested List  

12. ஒரு HTML ஆலணத் ில், கீழ்லிரிப் பட்டி஬ல் பபட்டிக஬ உருலொக்கப் ப஬ன்படும் ஒட்டு 
(A) <listbox>  (B) <dropdown>  (C) <input>  (D) <select>  

13. CSS –க஬ பின்லரு஫ொறு அகறக்கயொம்: 
(அ) Inline Style Sheets   (ஆ) Sitewide Style Sheets  
(இ) Internal Inline Sheets  (ஈ) Internal Style Sheets 

14. இலற்மில் எது ஫டக்கு கூற்று அல்ய. 
(a) Do-While  (b) Switch (c) For (d) While 

15. நீண்ட நி஭ல்கள் ெிமி஬ பிரிவுகரொகப் பிரிக்கப்படுலது 
அ) கணங்கள்   ஆ) கூறுகள்  இ) குழு ஈ) ப ொகு ி 
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பகு ி – II 
ஏதேனும் 6 லினொக்களுக்கு லிடை஬ரிக்கவும். (லினொ எண்.24 – கட்ைொ஬ லினொ)   6 X 2 = 12 

16. ே஭வு ஫ற்றும் ேகலல் தலறுபடுத்துக. 
ே஭வு ேகலல் 
பல்பலறு லகககரிலும்  ி஭ட்டப்படும் 
பெ஬ற்படுத் ப்படொ  அடிப்பகட பெய் ித் 
துணுக்கு  ஭வு எனப்படும். 

 கலல் என்பது முடிவுககர 
எடுக்கக்கூடி஬ உண்க஫கரின் 
ப ொகுப்பொகும். 

(எ.கொ) அருண், 16 (எ.கொ) அருணின் ல஬து 16 
17. நி஭ல்கவுண்ட்ைர் என்மொல் என்ன? 

 நி஭யின் அடுத்து பெ஬ற்படுத்  பலண்டி஬ கட்டகர஬ின் முகலரிக஬ க஫஬ச் 
பெ஬யகத் ிலுள்ர கணி  ஏ஭ணச்பெ஬யகம் நிகனலக முகலரி஬ின்  ெிி்மப்பு ப ிபலடொன  
நி஭ல் ப ிபலட்டில் (Program Counter) பெ஫ித்து கலக்கும்.  

18. பய ப஬னர் இ஬க்க அட஫ப்பு என்மொல் என்ன? 
 ஒப஭ பந஭த் ில் ஒன்றுக்கும் ப஫ற்பட்ட ப஬னர்கள், ஒப஭ ஫ொ ிரி஬ொன  ஭வுககரம௃ம் 

ப஬ன்பொடுககரம௃ம் கணிப்பபொமி஬ில் ப஬ன்படுத்  அனு஫ ிக்கும் இ஬க்க அக஫ப்பு “பய 
ப஬னர் இ஬க்க அக஫ப்பு” எனப்படும். 
எ.கொ: Windows, Unix, Linux 

19. நுண்ணடமச் சுட்டி என்மொல் என்ன?  
 அட்டலகணத் ொள் முழுலதும் நகர்த் க்கூடி஬ பெவ்லக லடிலியொன பபட்டி பபொன்ம 

அக஫ப்பு நுண்ணகமச்சுட்டி என்று அகறக்கப்படுகிமது. 
20. லடய஬ட஫ப்பு என்மொல் என்ன? 

 லகய஬க஫ப்பு என்பது கணிப்பபொமி ெொர்ந்  லரங்ககர பகிர்ந்து பகொள்ளும் 
பநொக்கத் ிற்கொக ஒன்பமொபடொன்று இகணக்கப்பட்ட ெொ னங்கரின் ப ொகுப்பொகும். 

21. (i) <strong> (ii) <em> ஒட்டுகள் பற்மி குமிப்பு லட஭க. 
HTML ஆனது Bold ஫மறும் italic ஒட்டுகளுடன் <strong>, <em> ஒட்டுககரம௃ம் கூடு யொக 
லறங்குகிமது.  

(i) <strong> ஒட்டொனது உக஭க஬  டித்  எழுத்துக்கரில் பலரிப்படுத்தும். 
(ii) <em> ஒட்டொனது உக஭க஬ ெொய்ந்  எழுத்துக்கரில் பலரிப்படுத்தும். 

22. ஒரு தகொப்டப எவ்லொறு ஫றுபப஬ரிடுலரீ்கள்? 
஫றுபப஬ரிட பலண்டி஬ பகொப்கப ப ர்வு பெய்து,  
 File -> Rename என்ம பட்டிப்பட்கட ப ர்லின் மூயமும், 
 பகொப்பின் ஫ீது லயது கிரிக் பெய்து லரும் பட்டி஬யில் Rename என்ம ப ர்கல கிரிக் 

பெய்ல ன் மூயமும், 
 லிகெப்பயகக஬ில் உள்ர F2 பபொத் ொகன அழுத்துல ன் மூயமும் ஫றுபப஬ரிடயொம். 

23. <marquee> ஒட்டின் பபொது லடிலத்டே எழுது. 
பபொது லடிலம்: <marquee> Text or image to be scroll </marquee> 

24. குமிம௃ரு அரவு என்மொல் என்ன? 
 கணிப்ப஧ொ஫ிகள் ந஥ர்நற஫ (கு஫ியு஫ொ) நற்றும் எதிர்நற஫ (கு஫ியுரு) எண்கற஭க் 

றகனொளும் தி஫ன் ப஧ற்஫றய.  
 எதிர்நற஫ இரு஥ிற஬ எண்கற஭ எ஭ிதொக கு஫ிக்க ஧னன்஧டும் முற஫ “குறியுரு அளவு” 

(Signed Magnitude) முற஫ என்று அறமக்கப்஧டுகி஫து.  
 “கு஫ியுரு அ஭வு” முற஫னில், இடது ஓப ஧ிட்டொ஦(Left most bit), நிகு நதிப்பு ஧ிட்(MSB) “கு஫ி 

஧ிட்” (Sign Bit) அல்஬து “சந஥ிற஬஧ிட்” (Parity Bit) எ஦அறமக்கப்஧டுகி஫து.  
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பகு ி – III 
ஏதேனும் 6 லினொக்களுக்கு லிடை஬ரிக்கவும். (லினொ எண்.33 – கட்ைொ஬ லினொ)    6 X 3 = 18 

25. உள்ரடீ்டு சொேனங்கள் என்மொல் என்ன? இ஭ண்டு எடுத்துக்கொட்டுகள் ேருக. 
 அகனத்து லகக஬ொன  ஭வுககரம௃ம் கணிப்பபொமிக்குள் உள்ரிட ப஬ன்படுத்தும் 

ெொ னங்கள் உள்ரடீ்டுச் ெொ னங்கள் எனப்படும்.எ.கொ: லிகெப்பயகக,சுட்டி. 
26. கி஭ொக்கிங் பற்மி ெிறுகுமிப்பு லக஭க. 

 ெட்டலிப஭ொ ஫ொக பிம஭து ப஬னர் பப஬ர் ஫ற்றும் கடவுச்பெொல்கய உகடத்து 
கணிப்பபொமி அல்யது பிகண஬த் ில் நுகறலது கி஭ொக்கிங் எனப்படும். 

27. GUI என்மொல் என்ன? 
 லக஭ககய ப஬னர் இகடமுகம் (GUI) ென்னல்  ிக஭ அடிப்பகட஬ியொன, பந஭டி஬ொக 

உள்ரடீ்டு / பலரி஬டீுககர கக஬ொள்ல ற்கும், பட்டிகரியிருந்து ப ர்வு பெய்ல ற்கும், 
ப ர்ந்ப டுப்ப ற்கு ப கல஬ொன சுட்டும் கருலிககரக் (Pointing devices) பகொண்டது. 

 லக஭ககய ப஬னர் இகடமுகத் ின் கலரும் லண்ணங்கள், ப஬னக஭ எரி ொக 
ஈர்க்கின்மது. 

28. ே஭லின் அரடலப் பபொறுத்து நுண்பச஬யிட஬ லடகப்படுத்துக. 
பெ஬யொக்கப்படும்  ஭லின் அகயத்க  பபொறுத்து நுண்பெ஬யிக஬ லககப்படுத் யொம். 
 8 - பிட் நுண்பெ஬யி 
 16 - பிட் நுண்பெ஬யி 
 32 - பிட் நுண்பெ஬யி 
 64 - பிட் நுண்பெ஬யி 

29. கொல்க்-ல் பநடுலரிடச ஫ற்றும் லரிடசகடர தசர்த்ேல் பற்மி எழுதுக. 
பநடுலரிடசட஬ தசர்த்ேல்:  
 பு ி஬ பநடுலரிகெ பெர்க்கப்பட பலண்டி஬ பநடுலரிகெ஬ில் கிரிக் பெய்து, அ கன 

ப ர்ந்ப டுத்து, சுட்டி஬ில் லயது கிரிக் பெய் ொல் ப ொன்றும் ப஫ல்஫ீட்பு 
பபட்டி஬ியிருந்து, “Insert Columns” என்ம கட்டகரக஬ ப ர்வு பெய்஬ பலண்டும் 

 இப்பபொழுது, ஒரு பு ி஬ பநடுலரிகெ நடப்பு பநடுலரிகெக்கு இடது பக்கத் ில் 
பெர்க்கப்பட்டிருக்கும்.  

லரிடசகடர தசர்த்ேல்: 
 எந்  லரிகெக்கு ப஫ல் ஒரு பு ி஬ லரிகெ பெர்க்கப்பட பலண்டுப஫ொ , அந்  லரிகெ எண்கண 

கிரிக் பெய்து, அந்  லரிகெக஬ ப ர்ந்ப டுத்து, சுட்டி஬ில் லயது கிரிக் பெய் ொல் 
ப ொன்றும் ப஫ல்஫ீட்பு பபட்டி஬ியிருந்து, “Insert Rows” என்ம கட்டகரக஬ ப ர்வு பெய்஬ 
பலண்டும். 

 இப்பபொழுது, ஒரு பு ி஬ லரிகெ ப ர்வு பெய்஬ப்பட்ட லரிகெக்கு ப஫ல் பக்கத் ில் 
பெர்க்கப்பட்டிருக்கும்.  

30. தைட்ைொகொர்டு (Data card) ஫ற்றும் ைொங்கில்ஸ் (Dongles) தலறுபடுத்துக. 
Dongle Data Card 

கூடு ல் பொதுகொப்கப லறங்கும் 
நீக்கக் கூடி஬ (removable) கூறுககர 
குமிக்கிமது.  

இது  ஭வுககர பெ஫ித்து கலக்க 
ப஬ன்படும் நீக்கக்கூடி஬ ஫ின்னணு 
அட்கட ஆகும்.  

ம௃.எஸ்.பி ைொங்கிரின் லடககள் 
 WIFI டொங்கிள் 
 BLUETOOTH  
 MEMORY டொங்கிள் 

DATACARD ன் லடககள் 
 Expansion Card 
 Memory Card or Fla  
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31. <UL> ஫ற்றும் <OL> ஒட்டுகடர தலறுபடுத்துக. 
<UL> ஒட்டு <OL> ஒட்டு 

லரிகெப்படுத் ப்படொ  பட்டி஬ல் அல்யது 
புல்யட் பட்டி஬ல்ககர லக஭஬றுக்கப் 
ப஬ன்படுகிமது. 

லரிகெப்படுத் ப்பட்ட பட்டி஬ல் அல்யது 
எண்லரிகெ பட்டி஬ல்ககர லக஭஬றுக்கப் 
ப஬ன்படுகிமது. 

<UL> ஒட்டுடன் type பண்புக்கூறு 
ப஬ன்படுகிமது. 

<OL> ஒட்டுடன் type ஫ற்றும் start 
பண்புக்கூறுகள் ப஬ன்படுகின்மன. 

லரிகெப்படுத் ப்படொ  பட்டி஬யில் 
உருப்படிகள் ெிமப்பு புல்யட் குமி஬டீுககர 
முன்ன ொக பகொண்டிருக்கும். 

எண்லரிகெப் பட்டி஬யொனது 
உருப்படிககர எண்லரிகெப்படிப஬ொ 
அல்யது அக஭லரிகெப்படிப஬ொ 
பட்டி஬யிட்டு கொட்டும்.  

32. ஜொலொஸ்கிரிப்ட்டில் உள்ர பல்தலறு கிடரப்பிரிப்பு கூற்றுகள் பட்டி஬யிடுக. 
 ஜொலொஸ்கிரிப்ட்டில் பயலி ஫ொன கிகரப்பிரிப்பு கூற்றுகள் உள்ரன. அகல,  

 if கூற்று  
 if …else கூற்று  
 else if கூற்று  
 switch கூற்று 

33. பலட்டுேல்,ஒட்டுேல் ஫ற்றும் நகபயடுத்ேல், ஒட்டுேல் – ஒப்பிைவும். 
பலட்டுேல் நகபயடுத்ேல் 

பகொப்பு அல்யது பகொப்புகமககர மூய 
இடத் ியிருந்து பு ி஬ இடத் ிற்கு 
நகர்த்து ல் பலட்டு ல் எனப்படும். 

பகொப்பு அல்யது பகொப்புகமகரின் 
பி஭ ிக஬ பு ி஬ இடத் ிற்கு நகர்த்து ல் 
நகபயடுத் ல் எனப்படும். 

மூயக் பகொப்புகள் அறிக்கப்படும். மூயக் பகொப்புகள் அறிக்கப்படுல ில்கய. 
கட்டகர: Edit → Cut (or) Ctrl + X 
         Edit → Paste (or) Ctrl + V          

கட்டகர: Edit → Copy (or) Ctrl + C 
         Edit → Paste (or) Ctrl + V          
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பகுேி – IV 
அடனத்து லினொக்களுக்கும் லிடை஬ரிக்கவும்.           5 X 5 = 25 
34. அ) ஒரு கணிப்பபொமி஬ின் அடிப்படை பொகங்கடர பேரிலொன லிரக்கப்பைத்துைன் 
லிரக்குக. 
 கணிப்பபொமி஬ில், பகொடுக்கப்பட்ட ஒவ்பலொரு பணிம௃ம், உள்ரடீு- பெ஬யொக்கம்-பலரி஬டீு 

என்ம சுறற்ெிக஬ அடிப்பகட஬ொகக் பகொண்டு பெ஬யொற்றுகிமது. 

 
 உள்ரடீ்ைகம்: அகனத்து லகக஬ொன  ஭வுககரம௃ம் கணிப்பபொமிக்குள் உள்ரிடப் 

ப஬ன்படுகிமது. உள்ரிடப்பட்ட  ஭வுகள் பெ஬யொக்கத் ிற்கொக நிகனலகத் ில் 
பெ஫ிக்கப்படுகின்மன. எ.கொ: லிடசப்பயடக, சுட்டி தபொன்மடல . 

 ட஫஬ச்பச஬யகம்: க஫஬ச்பெ஬யகம் என்பது, கணிப்பபொமிக்கு லறங்கப்படும் 
கட்டகரககரக், கணிப்பபொமி புரிந்துபகொள்ளும் லகக஬ில் ஫ொற்மி அ கன பெ஬யொக்கம் 
பெய்ம௃ம் மு ன்க஫஬ொன பகு ி஬ொகும். 
ட஫஬ச்பச஬யகத்ேில் மூன்று பகுேிகள் உள்ரன, அகல  

 கட்டுப்பொட்டகம், கணி  ஏ஭ணச் பெ஬யகம் ஫ற்றும் நிகனலகம் ஆகும்.  
 நிடனலகம்: மு ன்க஫ நிகனலகம் ஫ற்றும் இ஭ண்டொம் நிகய நிகனலகம் என இருலகக 

நிகனலகங்கள் உள்ரன. 
o கட்டகரகள் நிகமபலற்மத்  ஬ொ஭ொக இருக்கும் பபொது  ஭வு ஫ற்றும் நி஭ல்ககரத் 

 ற்கொயிக஫ொகச் பெ஫ிக்க மு ன்க஫ நிகனலகம் ப஬ன்படுகிமது.  
எ.கொ: பந஭டி அணுகல் நிகனலகம் (RAM - Random Access Memory) 

o  ஭வுககர நி஭ந் ஭஫ொகச் பெ஫ித்து கலக்க இ஭ண்டொம் நிகய நிகனலகம் 
ப஬ன்படுகிமது. எ.கொ: லன்லட்டு (Hard disk), குறுலட்டு (CD-ROM) ஫ற்றும் டிலிடி ப஭ொம் 
(DVD ROM) பபொன்மகல. 

 பலரி஬ீட்ைகம்: ப஬னர்கள் புரிந்து பகொள்ரக்கூடி஬ லகக஬ில்  கலகயத் ப ரிலிக்கும் 
எந் பலொரு லன்பபொருளும் பலரி஬டீ்டகம் எனப்படும். எ.கொ:  ிக஭஬கம், அச்சுப்பபொமி 
பபொன்மகல. 
(ஆ) (i) (98.46)10 க்கு நிக஭ொன இருநிடய எண்ணொக ஫ொற்றுக. 

      (ii) கூட்டுக: 11010102 + 1011012  
(i) (98.46)10 க்கு நிக஭ொன இருநிடய எண்: 

முழுஎண் பகுேிட஬ ஫ொற்றுேல்: (98)10 
 

2   98 

2   49 – 0 

2   24 – 1 

2   12 – 0 

2    6 – 0 

2    3 – 0 

     1 – 1 
 

98 க்கு நிக஭ொன இருநிடய எண்: 11000102 
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 ஫ிேப்புப் புள்ரி பகுேிட஬ ஫ொற்றுேல்: (0.46)10 
KOvz; gFjp 

0.46 x 2 =  0.92   0 

0.92 x 2 =  1.84   1 

0.84 x 2 =  1.68   1 

0.68 x 2 =  1.36   1 

0.36 x 2 =  0.72   0 
 

0.46f;F epfuhd ,Uepiy vz;: (0.01110 . . .)2 
 

(98.46)10 = (1100010. 0111 0. . .)2 

  (ii) கூட்டுக: 11010102 + 1011012  

    1101010 

       101101 

                   10010111  

 

35. அ) Slide Sorter கொட்சி ஫ற்றும் அேன் முக்கி஬த்துலத்டே லட஭஬றுக்கவும். 
 Slide Sorter கொட்ெி எல்யொ ெில்லுகலம௃ம் குறும்படம் லடிலத் ில் பொர்க்க உ வும் 

பொர்கல஬ொகும். 
 ெில்லுக்கொட்ெி஬ின் பந஭த்க  குமிப்பிடவும், இ஭ண்டு ெில்லுகளுக்கிகடப஬஬ொன 

பரி஫ொற்மத்க  பெர்க்கவும் ப஬ன்படுகிமது. 
 ப஫லும் இக  ப஬ன்படுத் ி எல்யொ பலகயக஬ம௃ம் ெில்லுலின் ப ொகுப்பிபயொ 

அல்யது  னி ெில்லுலிபயொ பெய்஬யொம். 
 ஒரு லரிகெ஬ில் ப ொன்றும் ெில்லுலின் எண்ணிக்கக஬ில் ஫ொற்மம் பெய்஬யொம். 

 
ஆ)கொல்க்-ல் பநடுலரிடச஬ின் அகயத்டே எவ்லொறு ஫ொற்மயொம் என்படே லிரக்குக. 
லறிமுடம 1.: 

 எந்  பநடுலரிகெ஬ின் அகயத்க  ஫ொற்ம லிரும்புகின்பமொப஫ொ அந்  
பநடுலரிகெக஬ ப ர்வு பெய்து, format → column → width என்ம கட்டகர அல்யது 
சுட்டிக஬ கலத்து லயது கிரிக் பெய்஬ பலண்டும். 

 ப ொன்றும் column width உக஭஬ொடல் பபட்டி஬ில் ப கல஬ொன அரகலக் பகொடுத்து OK 
பபொத் ொகன கிரிக் பெய்஬ பலண்டும். 

லறிமுடம 2.: 
 எந்  பநடுலரிகெ஬ின் அகயத்க  ஫ொற்ம லிரும்புகின்பமொப஫ொ அந்  பநடுலரிகெக஬, 

அடுத்  பநடுலரிகெ஬ியிருந்து பிரிக்கும் பகொட்டிற்கு சுட்டிக஬ எடுத்துச் பெல்யவும். 
 சுட்டி஬ின் சுட்டி இரு கய அம்புக்குமி஬ொக ஫ொறும். 
 அந்  நிகய஬ில் கிரிக் பெய்து சுட்டிக஬ இடப்புமம் அல்யது லயப்புமம் இழுத்து 

அகயத்க  குகமக்கபலொ அல்யது கூட்டபலொ பெய்஬யொம். 
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36. அ) ஓபன் ஆஃபீஸ் ட஭ட்ைரில் ஒரு பசொல்டய தேடி ஫ற்பமொரு பசொல்யொக ஫ொற்றும் 

லறிகடரப் பற்மி எழுது. 

ஓபன் ஆஃபஸீ் க஭ட்டரில் உள்ர Find and Replace லெ ி, ஆலணத் ில் உள்ர ஒரு பெொல்கயக் 
கண்டுபிடித்து அ கன பலபமொரு பெொல்யொக ஫ொற்மி஬ிட உ வுகிமது.  

 லறிமுடம: 
 Edit → Find & Replace அல்யது Ctrl+F கிரிக் பெய் ொல் Find & Replace உக஭஬ொடல் பபட்டி 

ப ொன்றும். 

 Search for பபட்டி஬ில் ப டபலண்டி஬ பெொல்கயம௃ம்,  

 Replace with பபட்டி஬ில் ஫ொமி ல஭பலண்டி஬ பெொல்கய  ட்டச்சு பெய்஬ பலண்டும். 
 Find பபொத் ொகன கிரிக் பெய் வுடன், ப டல் ப ொடங்கி, அந்  லொர்த்க க஬ 

கண்டுபிடித்து அ ன் மு ல் இருப்பிடத் ில் ஫ட்டும் உ஬ர்த் ிக்கொட்டப்படும். 

 உ஬ர்த் ிக் கொட்டப்பட்ட பெொல்கய ஫ட்டும் ஫ொற்மி஬ிடுல ற்கு Replace பபொத் ொகன கிரிக் 
பெய்஬ பலண்டும்.  

 Find All கிரிக் பெய் ொல் ஆலணத் ில் எல்யொ இடங்கரிலும் ப டப்பட்டு அந்  
பெொல்யொனது அகனத்து இடத் ிலும் ப ர்வு பெய்஬ப்பட்டு உ஬ர்த் ிக்கொட்டப்படும்.. 

 Replace All பபொத் ொகன கிரிக்பெய் ொல் உ஬ர்த் ிக்கொட்டப்பட்ட எல்யொ இடத் ிலும் 

஫ொற்மப்பட்டிருக்கும். Close  பபொத் ொகன கிரிக் பெய்஬ பலண்டும். 

ஆ) ேகுந்ே HTML நி஭லுைன் பட்டி஬யின் லடககடர பற்மி லிரக்குக. 
HTML-ல் மூன்று லடக஬ொன பட்டி஬ல்கள் உள்ரன,  
 லரிகெ படுத் ப்பட்ட பட்டி஬ல்கள் (Ordered List) 

 லரிகெப்படுத் ப்படொ  பட்டி஬ல்கள் (Unordered List) 

 லக஭஬கமபட்டி஬ல்கள்  ( Definition List) 

எண் லரிடசப்பட்டி஬ல் / லரிடசப்படுத்ேப்பட்ைபட்டி஬ல்:  
 எண் லரிகெப்பட்டி஬யொனது <OL> ….. </OL> என்ம இகண ஒட்டுகரொல் 

உருலொக்கப்படுகின்மன.  
 பட்டி஬யில் ஒரு உருப்படிக஬ பெர்க்க <LI> ஒட்டொனது ப஬ன்படுகின்மது.  
 எண்லரிகெப்பட்டி஬யொனது உருப்படிககர எண்லரிகெப்படிப஬ொ அல்யது 

அக஭லரிகெப்படிப஬ொ பட்டி஬யிட்டு கொட்டும்.  
 <OL> ஫ற்றும் <LI> என்ம இ஭ண்டு ஒட்டுகளும் அகடவு ஒட்டுகரொகும்.  
எண் லரிடசஇைப்பைொேபட்டி஬ல் / லரிடசப்படுத்ேொேபட்டி஬ல்:  
 லரிகெப்படுத் ொ  பட்டி஬யொனது புல்யட் பட்டி஬ல்கள் எனவும் அகறக்கப்படுகிமது.  
 எண்களுக்கு ப ியொக ெிமப்பு புல்யட் குமி஬டீுககர முன்ன ொக பகொண்டிருக்கும். 

லரிகெப்படுத் ப்படொ  பட்டி஬ல் ஆனது <UL> ……… </UL> என்ம இகணஒட்டுகளுக்குள் 
லக஭஬றுக்கப்பட்டிருக்கும். 

லட஭஬டமப்பட்டி஬ல்: 
 லக஭஬கமப் பட்டி஬யொனது ஫ற்ம இ஭ண்டு பட்டி஬ல்கரில் இருந்து ஫ொறுபடுகிமது.  
 பட்டி஬ல் உருப்படிக்கு முன்னொல் புல்யட் குமி஬பீடொ அல்யது எண் லரிகெ குமி஬பீடொ 

இருக்கொது. இம்முகம஬ில் பட்டி஬ல் உறுப்புகள் இ஭ண்டு பகு ிககர பகொண்டுள்ரது. 
(1) லக஭஬கம  கயப்பு (2) லக஭஬கம லிரக்கம்  

 லக஭஬கமப் பட்டி஬யொனது <DL> ……. </DL> என்ம இகண ஒட்டுகளுக்குள் 
லக஭஬றுக்கப்பட்டிருக்கும்.  

 லக஭஬கமத்  கயப்பொனது <DT> ….. </DT> ஒட்டுகளுக்குள்  ஭ப்படல் பலண்டும். 
 லக஭஬கமத்  கயப்பின் லிரக்க஫ொனது <DD> ………… </DD> ஒட்டுகளுக்குள்  ஭ப்படல் 

பலண்டும். 
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37. அ) லிண்தைொஸ் இ஬க்கஅட஫ப்பின் பயலடக஬ொன பேிப்புகடர லிலரி. 
i) tpz;Nlh]; 1.x: 1985: 

 16 gpl;Lfspy; tiufiy gadh; ,ilKfk; mwpKfk; nra;ag;gl;lJ. 

 cs;sPl;L rhjdkhf Rl;b mwpKfkhdJ. 

ii) tpz;Nlh]; 2.x: 1987: 

 rd;dy; jpiuia rpwpjhf;Fjy; my;yJ nghpjhf;Fjy; trjp. 

 fl;Lg;ghl;lfk; mwpKfk; nra;ag;gl;lJ. 

iii) tpz;Nlh]; 3.x: 1992: 

 “gy;gzp fUj;JU” mwpKfkhdJ. 

 256 tz;zq;fis ,af;Fk; jpwNdhL kpfetPd tz;zkakhdJ. 

iv) tpz;Nlh]; 95: 1995: 

 njhlf;f nghj;jhd;> njhlf;fg;gl;b> gzpg;gl;il> tpz;Nlh]; vf;];g;Nshuh; 

mwpKfkhdJ. 

 32gpl; Ez;nrayp mwpKfkhdJ 

v) tpz;Nlh]; 98: 1998: 

 Internet Explorer vd;Dk; cytp mwpKfkhdJ. 

 tpz;Nlh]; mbg;gilapyhd tpisahl;Lfs; Nkk;gLj;jg;gl;lJ 

vi) tpz;Nlh]; NT: 

 tiyaikg;gpy; Nritafkhf tbtikf;fg;gl;lJ. 

vii) tpz;Nlh]; 2000: 2000 

 ehd;F gjpg;Gfs; ntspaplg;gl;ld. 

viii) tpz;Nlh]; XP: 2001 

 64-gpl; Ez;nraypfs; mwpKfk;. 

 tpz;Nlh]; Njhw;wk; kw;Wk; gzpj;jsk; Nkk;gLj;jg;gl;lJ. 

ix) tpz;Nlh]; 7: 2009 

 fzpg;nghwpapd; njhlq;Fjy; Neuk; Nkk;gLj;jg;gl;lJ 

 VNuh gPf;> gzpg;g;ilapy; gad;ghLfis ,izj;jy;> ifnaOj;J czh;jy;> 

,d;lh;nel; vf;];g;Nshuh; 8 Nghd;w Gjpa gadh; ,ilKf trjpfs; 

mwpKfg;gLj;jg;gl;lJ 

x) tpz;Nlh[; 8: 2012 

 gy; mLf;F Ez;nrayp> njhLjpiu> khw;W cs;sPl;L Kiwfs; Nghd;w 

rpwg;gk;rq;fs; Nrh;f;fg;gl;lJ. 

 ifNgrp kw;Wk; fzpg;nghwpfSf;fhd nghJthd gzpNkilahf 

nray;gLfpwJ. 

xi) tpz;Nlh]; 10: 2015 

 xd;Wf;Fk; Nkw;gl;l jpiu Kfg;G. 

 “nrayp mwptpg;G” kw;Wk; “tpiuT eltbf;if nraypf;fhd kj;jpa mwptpg;G 

ikak;” mwpKfk;. 
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 ஆ) ஒப்பீட்டுச் பச஬ற்குமிட஬ பற்மி ேகுந்ே எடுத்துக்கொட்டுைன் லிரக்குக. 
 ஒப்படீ்டு பெ஬ற்குமிகள் இ஭ண்டு ஫ ிப்புககர ஒப்படீ்டு அ ன் லிகரகல ப஫ய் அல்யது 

பபொய் என்ம லிகரகல அமிலிக்கும்.  

 == (ெ஫ம்), != (ெ஫஫ில்கய ), < (ெிமி஬ ொக), > (பப ரி஬ ொக), <= (ெிமி஬ ொக அல்ய து ெ஫ம்), ஫ற்றும் 

>= (பப ரி஬ ொக அல்யது ெ஫ம்)  பபொன்ம ப஫ம்படுத் ப்பட்ட ஒப்பிட்டு பெ஬ற்குமிகள் 

ஜொலொஸ்கிரிப்ட் –ல் உள்ரது.  

x=10 ஫ற்றும் y=20 என்று எடுத்துக்பகொள்ரயொம். 

ஒப்படீ்டு 

பெ஬ற் குமி  
பபொருள்  எடுத்துக்கொட்டு  லிகரவு 

==  ெ஫ம் (Equality)  x==y  FALSE 

!=  ெ஫஫ில்கய (In-equality)  x!=y  TRUE 

<  ெிமி஬ ொக (Less-than)  x<y  TRUE 

>  பப ரி஬ ொக (Greater-than)  x>y  False  

<= 
ெிம஬ ொக அல்யது ெ஫ம் (Less-

than orequal to)  
x<=y  TRUE 

>= 
பபரி஬ ொக அல்யது ெ஫ம் 

(Greater-than or equal to)  
x>=y  FALSE 

 

38. அ) for ஫ைக்டக ஒரு எடுத்துக்கொட்டுைன் லிரக்குக. 
 for ஫டக்கு முன் லக஭஬றுக்கப்பட்ட எண்ணிக்கக஬ில் ஫ீண்டும் ஫ீண்டும் இ஬ங்கும்.  
கட்ைடர அட஫ப்பு:  

for(initialization; condition; increment/decrement)  
{  

Body of the loop;  
}  

 for கட்டக஫ப்பில் மூன்று பகு ிகள் உள்ரன. அகல முக்கொற்புள்ரி஬ொல் 
பிரிக்கப்பட்டிருக்கும்.  
1) ஫டக்கின் மு ல் பகு ி ஫ொமிக்கு ப ொடக்க ஫ ிப்பிருத்தும், அந்  ஫ொமிக஬ 

கட்டுப்பொட்டு ஫ொமி என்பர். 
2) இ஭ண்டொம் பகு ி ஒரு நிபந் கன கூற்மொகும். அது ஫டக்கு எத் கன முகம 

இ஬க்கப்படும் என்று  ீர்஫ொனிக்கும். 

3) மூன்மொம் பகு ி கட்டுப்பொட்டு ஫ொமி஬ின் ஫ ிப்பு எவ்லொறு ஫ொற்மப்படும் என்று 
 ீர்஫ொனிக்கும் (஫ிகுக்க/ குகமக்க) 

எ.கொ: for( var n = 0; n <= 10; n++) 

{  
document.write(n+"  "); 

} 

     பலரி஬ீடு: 1 2 3 4 5 6 7 8 9 10  
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ஆ) ஏதேனும் 5 இடண஬ ப஬ன்பொடுகள் பற்மி ேகுந்ே எடுத்துக்கொட்டுைன் லிலரி?. 
 இடண஬த்ேில் பபொருள்கடர லொங்குேல் (ONLINE SHOPPING): இகண஬஫ொனது 

ப஫ய்நிகர் ெந்க கரொல் (Online Shopping) கட்டக஫க்கப்பட்டு உள்ரடக்கி஬ பு ி஬ ெந்க  
முகம லெ ிக஬ அமிமுகப்படுத்துகின்மது. (www) பெகல஬ங்கள் மூயம் பபொருள்ககர 
பற்மி஬ லிப஭ங்ககரப஬ொ அல்யது லறங்கும் பெகலகள் பற்மி஬  கலல்ககரப஬ொ 
லகயத் ரத் ில் அமிந்து பகொள்ரமுடிம௃ம். (எ.கொ.) amazon.com உயகரொலி஬ லகயக஬ 
அடிப்பகட஬ொக பகொண்டு (இகண஬த்க ) இகண஬த் ில் பெ஬ல்படும் புத் க ககட 
ஆகும்.  

 பங்குச் சந்டே பற்மி஬ ேகலல்கடர பபறுேல் (Stock market updates): இகண஬த் ின் 
மூயம் லடீ்டில் இருந் படிப஬ நிறுலனங்கரின் பங்குககர லொங்கபலொ, லிற்கபலொ 
முடிம௃ம்.  

 ஫ின் கற்மல் (e-learning): ஫ின் கற்மல் என்பது இகண஬த் ின் லறி஬ொக எங்கிருந்தும் 
கற்ப ற்கு லறங்கப்படும் கல்லி முகம஬ொகும்.  

 ஫ின் ஆளுட஫ (e - governance): இகண஬ம் மூயம் அ஭ெொங்கம் லறங்கும் பெகலககரப் 
பபமவும், அகல ப ொடர்பொன  கலல்ககர ப ரிந்து பகொள்ரவும் உ வும் ப஬ன்பொடு 
஫ின் ஆளுக஫ எனப்படும்.  

 ஫ின்-லங்கி (e-banking): ஫ின் லங்கி என்பது இகண஬ லங்கி எனவும் அகறக்கப்படுகிமது. 
ஒரு லங்கி஬ின் லொடிக்கக஬ொரர் அல்யது நி ி நிறுலனம் ஆனது  னது லகய஬கத் ின் 
மூயம் நி ி பரிலர்த் கனககர ப஫ற்பகொள்ர உ வுகிமது. 
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